
MICROSOFT WORD 

 

🔓 PART 1 — PENGENALAN Microsoft Word 

Akses: UMUM (tanpa login) 

 

1. Pengertian Microsoft Word 

Microsoft Word adalah salah satu aplikasi pengolah kata yang digunakan untuk membuat, 
mengedit, dan mengelola dokumen berbentuk teks. Aplikasi ini dikembangkan oleh Microsoft 
dan menjadi bagian dari paket Microsoft Office. Microsoft Word banyak digunakan karena 
tampilannya mudah dipahami dan fiturnya mendukung berbagai kebutuhan penulisan. 

 

2. Fungsi Microsoft Word 

Fungsi utama Microsoft Word adalah membantu pengguna dalam mengolah dokumen teks 
secara digital. Dengan Microsoft Word, pengguna dapat: 

• Mengetik dan menyunting teks 

• Mengatur tampilan tulisan dan paragraf 

• Menyusun dokumen secara rapi dan terstruktur 

 

3. Kegunaan Microsoft Word 

Microsoft Word digunakan dalam berbagai bidang, antara lain: 

• Pendidikan (tugas, makalah, laporan) 

• Perkantoran (surat resmi, dokumen administrasi) 

• Kegiatan pribadi (CV, proposal, catatan) 

Kegunaannya menjadikan Microsoft Word sebagai aplikasi yang penting untuk dikuasai. 

 

4. Microsoft Word sebagai Aplikasi Pengolah Kata 

Sebagai aplikasi pengolah kata, Microsoft Word menyediakan berbagai fitur untuk mengatur 
teks, seperti pengaturan huruf, paragraf, dan halaman. Fitur-fitur tersebut membantu 
pengguna membuat dokumen yang rapi, mudah dibaca, dan sesuai kebutuhan. 

 

 



5. Contoh Penggunaan Microsoft Word dalam Kehidupan Sehari-hari 

Dalam kehidupan sehari-hari, Microsoft Word sering digunakan untuk: 

• Membuat surat undangan 

• Menulis laporan kegiatan 

• Menyusun tugas sekolah 

• Membuat dokumen sederhana lainnya 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



PART 2 — SEJARAH & PERKEMBANGAN Microsoft Word 

Akses:LOGIN + ikut kursus 

 

1. Pengembang Microsoft Word 

Microsoft Word dikembangkan oleh perusahaan teknologi bernama Microsoft. Perusahaan 
ini dikenal sebagai pengembang berbagai perangkat lunak yang digunakan di seluruh dunia. 
Microsoft Word dibuat sebagai bagian dari paket Microsoft Office untuk membantu 
pekerjaan pengolahan dokumen secara digital. 

 

2. Latar Belakang Dibuatnya Microsoft Word 

Sebelum adanya Microsoft Word, penulisan dokumen dilakukan menggunakan mesin ketik. 
Proses tersebut membutuhkan waktu lama dan sulit diperbaiki jika terjadi kesalahan. Oleh 
karena itu, Microsoft Word dikembangkan untuk mempermudah pengetikan, penyuntingan, 
dan penyimpanan dokumen dengan bantuan komputer. 

 

3. Tujuan Dibuatnya Microsoft Word 

Tujuan utama Microsoft Word adalah: 

• Mempermudah pengguna dalam membuat dokumen teks 

• Membantu penyusunan dokumen agar lebih rapi dan terstruktur 

• Menghemat waktu dalam penulisan dan pengeditan dokumen 

• Mengurangi kesalahan pengetikan karena dokumen dapat diperbaiki kapan saja 

Dengan tujuan tersebut, Microsoft Word menjadi solusi pengolahan kata yang praktis. 

 

4. Perkembangan Microsoft Word dari Waktu ke Waktu 

Seiring perkembangan teknologi komputer, Microsoft Word juga terus mengalami 
pembaruan. Perkembangan tersebut meliputi: 

• Perubahan tampilan agar lebih sederhana dan mudah digunakan 

• Penambahan fitur pengolahan teks dan dokumen 

• Kemampuan menyimpan dokumen dalam berbagai format 

• Dukungan penggunaan pada berbagai perangkat 

Perkembangan ini membuat Microsoft Word tetap digunakan hingga sekarang. 



 

5. Alasan Microsoft Word Banyak Digunakan 

Microsoft Word banyak digunakan di berbagai bidang karena: 

• Mudah dipelajari oleh pemula 

• Memiliki fitur yang lengkap untuk kebutuhan dokumen 

• Digunakan secara luas di sekolah, perkantoran, dan instansi 

• Mendukung pembuatan berbagai jenis dokumen 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



PART 3 — TAMPILAN & BAGIAN MICROSOFT WORD 

Akses:  LOGIN + ikut kursus 

 

1. Tampilan Awal Microsoft Word 

Saat Microsoft Word dijalankan, pengguna akan melihat tampilan awal berupa jendela 
aplikasi dengan lembar dokumen kosong. Tampilan ini dirancang agar pengguna dapat 
langsung mulai mengetik dan mengolah dokumen tanpa pengaturan yang rumit. 

 

2. Title Bar 

Title Bar terletak di bagian paling atas jendela Microsoft Word. Bagian ini berfungsi untuk 
menampilkan nama dokumen yang sedang dibuka serta nama aplikasi Microsoft Word. Selain 
itu, pada Title Bar juga terdapat tombol untuk menutup, memperkecil, dan memperbesar 
jendela aplikasi. 

 

3. Ribbon atau Menu Bar 

Ribbon atau Menu Bar merupakan bagian yang berisi kumpulan menu dan ikon perintah. Di 
dalam Ribbon terdapat berbagai tab menu yang dikelompokkan berdasarkan fungsinya. 
Ribbon membantu pengguna mengakses fitur pengolahan dokumen dengan cepat dan mudah. 

 

4. Quick Access Toolbar 

Quick Access Toolbar adalah toolbar yang berisi tombol perintah yang sering digunakan, 
seperti perintah menyimpan, membatalkan perintah, dan mengulangi perintah. Toolbar ini 
bertujuan untuk mempercepat pekerjaan pengguna saat mengolah dokumen. 

 

5. Area Kerja (Lembar Dokumen) 

Area kerja adalah bagian utama tempat pengguna mengetik, mengedit, dan menyusun teks. 
Semua isi dokumen ditampilkan pada area ini. Pengguna dapat menambahkan teks, 
menghapus teks, serta mengatur tata letak dokumen melalui area kerja. 

 

6. Status Bar 

Status Bar terletak di bagian bawah jendela Microsoft Word. Bagian ini menampilkan 
informasi mengenai dokumen, seperti jumlah halaman, posisi kursor, dan status dokumen 
yang sedang dikerjakan. 



 

7. Scroll Bar 

Scroll Bar digunakan untuk menggulir tampilan dokumen ke atas, ke bawah, ke kiri, atau ke 
kanan. Fitur ini membantu pengguna melihat bagian dokumen yang tidak terlihat pada layar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



PART 4 — MENU DAN FUNGSI DASAR Microsoft Word 

Akses: LOGIN + ikut kursus 

 

1. Menu File 

Menu File digunakan untuk mengelola dokumen secara keseluruhan. Melalui menu ini, 
pengguna dapat membuat dokumen baru, membuka dokumen yang sudah ada, menyimpan 
dokumen, serta mencetak dokumen. Menu File juga digunakan untuk mengatur pengaturan 
dasar dokumen sebelum digunakan lebih lanjut. 

 

2. Menu Home 

Menu Home merupakan menu yang paling sering digunakan dalam Microsoft Word. Menu 
ini berisi perintah-perintah dasar untuk mengolah teks, seperti mengatur jenis huruf, ukuran 
huruf, warna teks, serta mengatur paragraf. Dengan menu Home, pengguna dapat 
memperbaiki tampilan dokumen agar terlihat rapi dan mudah dibaca. 

 

3. Menu Insert 

Menu Insert digunakan untuk menyisipkan berbagai objek ke dalam dokumen. Objek yang 
dapat ditambahkan antara lain tabel, gambar, simbol, dan bentuk sederhana. Menu ini 
membantu pengguna memperkaya isi dokumen sehingga tidak hanya berisi teks saja. 

 

4. Menu Layout / Page Layout 

Menu Layout atau Page Layout berfungsi untuk mengatur tata letak halaman dokumen. 
Melalui menu ini, pengguna dapat mengatur margin, ukuran kertas, dan orientasi halaman. 
Pengaturan tata letak ini penting agar dokumen sesuai dengan kebutuhan pencetakan. 

 

5. Menu View 

Menu View digunakan untuk mengatur tampilan dokumen di layar. Dengan menu ini, 
pengguna dapat memilih tampilan yang paling nyaman saat bekerja, seperti tampilan satu 
halaman atau beberapa halaman sekaligus. 

 

 

 

 



PART 5 — PENGOLAHAN TEKS DASAR MICROSOFT WORD 

Akses:  LOGIN + ikut kursus 

 

1. Mengetik Teks 

Mengetik teks merupakan kegiatan utama dalam Microsoft Word. Pengguna dapat menulis 
berbagai jenis dokumen dengan memanfaatkan papan ketik. Teks yang diketik akan langsung 
muncul pada area kerja dokumen. 

 

2. Menghapus dan Memperbaiki Teks 

Microsoft Word memungkinkan pengguna untuk menghapus teks yang tidak diperlukan dan 
memperbaiki kesalahan pengetikan. Proses ini dapat dilakukan dengan mudah tanpa harus 
mengulang pengetikan dari awal. 

 

3. Menyalin, Memotong, dan Menempel Teks 

Fitur menyalin, memotong, dan menempel teks digunakan untuk memindahkan atau 
menggandakan teks. Fitur ini sangat membantu saat menyusun dokumen agar pekerjaan lebih 
cepat dan efisien. 

 

4. Mengatur Jenis, Ukuran, dan Warna Huruf 

Microsoft Word menyediakan berbagai pilihan jenis huruf, ukuran huruf, dan warna teks. 
Pengaturan ini digunakan untuk menyesuaikan tampilan tulisan agar lebih menarik dan sesuai 
dengan kebutuhan dokumen. 

 

5. Mengatur Paragraf 

Pengaturan paragraf meliputi perataan teks, spasi baris, dan jarak antar paragraf. Dengan 
pengaturan paragraf yang baik, dokumen akan terlihat lebih rapi dan mudah dibaca. 

 

 

 

 

 

 



PART 6 — PENGATURAN DOKUMEN Microsoft Word 

Akses: LOGIN + ikut kursus 

 

1. Mengatur Margin 

Margin adalah jarak antara tepi kertas dengan area penulisan. Pengaturan margin digunakan 
agar teks tidak terlalu mepet dengan tepi halaman dan dokumen terlihat rapi. Microsoft Word 
menyediakan beberapa pilihan margin yang dapat disesuaikan dengan kebutuhan dokumen. 

 

2. Mengatur Ukuran Kertas 

Ukuran kertas menentukan luas halaman dokumen. Microsoft Word memungkinkan 
pengguna memilih berbagai ukuran kertas, seperti ukuran standar yang sering digunakan 
dalam pembuatan dokumen sekolah maupun perkantoran. Pengaturan ukuran kertas penting 
agar hasil cetakan sesuai dengan kebutuhan. 

 

3. Mengatur Orientasi Halaman 

Orientasi halaman digunakan untuk menentukan posisi halaman dokumen, apakah tegak atau 
mendatar. Pengaturan ini biasanya digunakan saat membuat dokumen dengan tabel atau 
gambar yang membutuhkan ruang lebih lebar. 

 

4. Mengatur Spasi Baris 

Spasi baris adalah jarak antara baris teks dalam paragraf. Pengaturan spasi baris membantu 
meningkatkan keterbacaan dokumen dan sering digunakan untuk menyesuaikan dokumen 
dengan aturan penulisan tertentu. 

 

5. Mengatur Perataan Teks 

Microsoft Word menyediakan beberapa jenis perataan teks, seperti rata kiri, rata kanan, rata 
tengah, dan rata kiri-kanan. Perataan teks digunakan agar tampilan paragraf sesuai dengan 
jenis dokumen yang dibuat. 

 

6. Membuat Dokumen Sederhana 

Dengan memanfaatkan pengaturan dokumen yang tersedia, pengguna dapat membuat 
dokumen sederhana yang rapi dan siap digunakan. Dokumen tersebut dapat berupa surat, 
laporan singkat, atau tugas sekolah. 



PART 7 MENYIMPAN & MENCETAK DOKUMEN MICROSOFT WORD 

Akses:  LOGIN + ikut kursus 

 

1. Menyimpan Dokumen 

Menyimpan dokumen merupakan langkah penting agar hasil pekerjaan tidak hilang. 
Microsoft Word menyediakan fitur penyimpanan yang memungkinkan dokumen disimpan ke 
dalam komputer dengan mudah. 

 

2. Menyimpan Dokumen dengan Nama dan Format Berbeda 

Pengguna dapat menyimpan dokumen dengan nama yang berbeda untuk membuat salinan 
dokumen. Selain itu, Microsoft Word juga mendukung berbagai format penyimpanan 
dokumen sesuai kebutuhan. 

 

3. Membuka Dokumen 

Microsoft Word memungkinkan pengguna membuka kembali dokumen yang telah disimpan. 
Fitur ini memudahkan pengguna untuk melanjutkan pekerjaan tanpa harus membuat 
dokumen baru. 

 

4. Mencetak Dokumen 

Setelah dokumen selesai dibuat, Microsoft Word dapat digunakan untuk mencetak dokumen. 
Pengguna dapat mengatur jumlah halaman dan hasil cetakan sebelum proses pencetakan 
dilakukan. 

 

5. Pengaturan Sebelum Mencetak 

Sebelum mencetak dokumen, pengguna dapat melakukan pengaturan seperti memilih ukuran 
kertas dan memastikan tata letak dokumen sudah sesuai. Pengaturan ini bertujuan agar hasil 
cetakan rapi dan sesuai kebutuhan. 

 

 

 

 

 



PRAKTIK DASAR — MENGENAL TAMPILAN & TOOLBAR Microsoft Word 

Catatan: 
Praktik ini wajib dikerjakan sebelum lanjut ke materi berikutnya agar siswa benar-benar 
paham letak menu dan toolbar. 

Tujuan Praktik 

Setelah menyelesaikan praktik ini, siswa diharapkan mampu: 

• Mengetahui letak toolbar dan menu di Microsoft Word 

• Mengenali fungsi bagian utama tampilan Word 

• Menggunakan menu dasar untuk mengolah teks sederhana 

LANGKAH 1 — MEMBUKA MICROSOFT WORD 

1. Nyalakan komputer atau laptop 

2. Klik tombol Start 

3. Cari dan buka aplikasi Microsoft Word 

4. Pilih Blank Document (Dokumen Kosong) 

 Setelah langkah ini, akan muncul tampilan awal Microsoft Word. 

 

LANGKAH 2 — MENGENALI BAGIAN TAMPILAN MICROSOFT WORD 

Perhatikan layar Microsoft Word yang terbuka, lalu kenali bagian-bagian berikut: 

1. Title Bar 

• Terletak di bagian paling atas layar 

• Menampilkan nama dokumen dan nama aplikasi 

2. Quick Access Toolbar 

• Terletak di pojok kiri atas 

• Berisi tombol cepat seperti Save (Simpan) dan Undo 

3. Ribbon / Menu 

• Terletak di bawah Title Bar 

• Berisi menu seperti Home, Insert, Layout, View 

• Digunakan untuk mengolah dokumen 

 

 



4. Area Kerja (Lembar Dokumen) 

• Berupa halaman putih besar 

• Tempat untuk mengetik dan mengedit teks 

5. Status Bar 

• Terletak di bagian bawah layar 

• Menampilkan informasi seperti nomor halaman 

 

LANGKAH 3 — MENGENAL MENU DASAR (RIBBON) 

Sekarang, klik satu per satu menu berikut: 

1. Menu Home 

Digunakan untuk: 

• Mengatur jenis huruf 

• Mengatur ukuran huruf 

• Mengatur warna teks 

• Mengatur paragraf 

2. Menu Insert 

Digunakan untuk: 

• Menyisipkan tabel 

• Menyisipkan gambar 

• Menambahkan simbol 

3. Menu Layout 

Digunakan untuk: 

• Mengatur margin 

• Mengatur ukuran kertas 

• Mengatur orientasi halaman 

 

 

 

 



4. Menu View 

Digunakan untuk: 

• Mengatur tampilan dokumen di layar 

 

LANGKAH 4 — PRAKTIK LANGSUNG MENGGUNAKAN TOOLBAR 

1. Ketik teks berikut di area kerja: 
Latihan Microsoft Word Dasar 

2. Lakukan pengaturan berikut: 

o Ubah jenis huruf 

o Ubah ukuran huruf 

o Ubah warna huruf 

o Ratakan teks ke tengah 

 

 EVALUASI PRAKTIK 

Siswa dinyatakan berhasil jika: 

• Dapat menunjukkan letak toolbar dan menu 

• Dapat menggunakan menu Home 

• Dapat mengubah tampilan teks 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

PRAKTIK  — PENGOLAHAN TEKS DASAR Microsoft Word 

Praktik ini melanjutkan praktik sebelumnya. 
Pastikan siswa sudah mengenal toolbar & menu sebelum masuk ke sini. 

Tujuan Praktik 

Setelah praktik ini, siswa mampu: 

• Mengetik dan mengedit teks 

• Menggunakan menu Home 

• Mengatur huruf dan paragraf 

• Menghasilkan dokumen sederhana yang rapi 

LANGKAH 5 — MENGETIK TEKS 

1. Pastikan dokumen Microsoft Word masih terbuka 

2. Arahkan kursor ke area kerja (lembar putih) 

3. Ketik teks berikut persis seperti ini: 

LATIHAN MICROSOFT WORD 

 

Microsoft Word adalah aplikasi pengolah kata yang digunakan 

untuk membuat dan mengedit dokumen teks. 

 

LANGKAH 6 — MENGEDIT TEKS 

1. Blok (sorot) judul LATIHAN MICROSOFT WORD 

2. Lakukan pengaturan berikut melalui menu Home: 

o Ubah jenis huruf 

o Ubah ukuran huruf 

o Ubah warna huruf 

3. Ratakan judul ke Tengah 



 

 

 

 

LANGKAH 7 — MENGATUR PARAGRAF 

1. Blok paragraf kedua 

2. Atur: 

o Perataan teks menjadi rata kiri-kanan 

o Spasi baris menjadi 1,5 

 Tujuannya agar teks terlihat lebih rapi dan nyaman dibaca. 

 

LANGKAH 8 — MENYIMPAN DOKUMEN 

1. Klik menu File 

2. Pilih Save As 

3. Tentukan lokasi penyimpanan 

4. Beri nama file: 
Latihan_Word_Dasar 

5. Klik Save 

 

EVALUASI PRAKTIK 

Siswa dinyatakan lulus praktik jika: 

• Dapat mengetik teks dengan benar 

• Dapat mengatur huruf dan paragraf 

• Dapat menyimpan dokumen 

 

 

 

 

 



 

 

 

 

PRAKTIK  — PENGATURAN DOKUMEN (LAYOUT HALAMAN) Microsoft Word 

Praktik ini fokus agar siswa tahu letak menu Layout dan bisa mengatur halaman 
dokumen dengan benar. 

 

Tujuan Praktik 

Setelah praktik ini, siswa mampu: 

• Menemukan menu Layout 

• Mengatur margin, ukuran kertas, dan orientasi halaman 

• Membuat dokumen yang siap dicetak 

LANGKAH 9 — MEMBUKA MENU LAYOUT 

1. Pastikan dokumen Microsoft Word masih terbuka 

2. Perhatikan Ribbon (menu di bagian atas) 

3. Klik menu Layout 

 Menu Layout berisi pengaturan tata letak halaman dokumen. 

 

LANGKAH 10 — MENGATUR MARGIN 

1. Di menu Layout, klik Margins 

2. Pilih margin Normal 

Margin berfungsi memberi jarak antara teks dan tepi kertas agar dokumen rapi. 

 

LANGKAH 11 — MENGATUR UKURAN KERTAS 

1. Masih di menu Layout, klik Size 

2. Pilih ukuran kertas A4 

Ukuran A4 adalah ukuran standar untuk tugas sekolah dan dokumen perkantoran. 

 



LANGKAH 12 — MENGATUR ORIENTASI HALAMAN 

1. Klik Orientation 

2. Pilih Portrait (Tegak) 

 Orientasi Portrait paling sering digunakan untuk dokumen teks. 

LANGKAH 13 — MENYIMPAN PERUBAHAN 

1. Klik File → Save 

2. Pastikan dokumen tersimpan dengan benar 

EVALUASI PRAKTIK 

Siswa dinyatakan berhasil jika: 

• Dapat menemukan menu Layout 

• Dapat mengatur margin dan ukuran kertas 

• Dokumen terlihat rapi dan siap dicetak 

PRAKTIK — HEADER, FOOTER & NOMOR HALAMAN Microsoft Word 

Praktik ini melatih siswa menemukan menu Insert dan menggunakan fitur dasar 
dokumen yang sering dipakai di tugas sekolah. 

Tujuan Praktik 

Setelah praktik ini, siswa mampu: 

• Menambahkan Header dan Footer 
• Memberi nomor halaman 
• Menyiapkan dokumen agar siap dicetak 

LANGKAH 14 — MEMBUKA MENU INSERT 

1. Pastikan dokumen Microsoft Word masih terbuka 
2. Perhatikan Ribbon (menu di bagian atas) 
3. Klik menu Insert 

 Menu Insert digunakan untuk menyisipkan elemen tambahan ke dokumen. 

 LANGKAH 15 — MEMBUAT HEADER 

1. Di menu Insert, klik Header 
2. Pilih salah satu model header sederhana 
3. Ketik teks berikut di area header: 

Latihan Microsoft Word 

 Header adalah teks yang muncul di bagian atas setiap halaman. 



 

 

 LANGKAH 16 — MEMBUAT FOOTER 

1. Masih di menu Insert, klik Footer 
2. Pilih model footer sederhana 
3. Ketik: 

Nama Siswa 

 Footer berada di bagian bawah halaman. 

LANGKAH 17 — MENAMBAHKAN NOMOR HALAMAN 

1. Klik Insert → Page Number 
2. Pilih posisi Bottom of Page 
3. Pilih model nomor halaman sederhana 

Nomor halaman membantu menyusun dokumen yang rapi. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

PRAKTIK  — MENYIAPKAN & MENCETAK DOKUMEN 

Tujuan Praktik 

Siswa mampu: 

• Mengecek tampilan dokumen sebelum dicetak 

• Melakukan pengaturan cetak dasar 

 LANGKAH 18 — PREVIEW DOKUMEN 

1. Klik menu File 

2. Pilih Print 

3. Perhatikan tampilan dokumen pada Preview 

 Preview digunakan untuk memastikan dokumen sudah rapi. 

 LANGKAH 19 — PENGATURAN CETAK 

Perhatikan pengaturan berikut: 

• Ukuran kertas: A4 

• Orientasi: Portrait 

• Jumlah halaman: All Pages 

(Tidak perlu mencetak sungguhan jika tidak ada printer) 

 LANGKAH 20 — MENYIMPAN DOKUMEN AKHIR 

1. Klik File → Save As 

2. Beri nama file: 
Dokumen_Word_Akhir 

3. Klik Save 

 

EVALUASI PRAKTIK  

Siswa dinyatakan tuntas jika: 

• Header & footer berhasil dibuat 

• Nomor halaman muncul 

• Dokumen siap dicetak 

 



LATIHAN SOAL PILIHAN GANDA 

Materi: Microsoft Word 

 

1.Pengertian Microsoft Word adalah … 
A. Aplikasi pengolah angka 
B. Aplikasi pengolah kata 
C. Aplikasi pengolah gambar 
D. Aplikasi pengolah video 
Answer: B 

 

2.Microsoft Word dikembangkan oleh perusahaan … 
A. Google 
B. Apple 
C. Microsoft 
D. IBM 
Answer: C 

 

3.Tujuan utama dibuatnya Microsoft Word adalah … 
A. Mengedit video 
B. Mengolah data jaringan 
C. Membantu pengolahan dokumen teks 
D. Membuat animasi 
Answer: C 

 

4.Microsoft Word termasuk ke dalam paket aplikasi … 
A. Adobe 
B. Corel 
C. Microsoft Office 
D. Linux 
Answer: C 

 

5.Contoh penggunaan Microsoft Word dalam kehidupan sehari-hari adalah … 
A. Mengedit foto 
B. Membuat surat dan laporan 
C. Membuat video 
D. Bermain game 
Answer: B 



6.Bagian Microsoft Word yang menampilkan nama dokumen disebut … 
A. Ribbon 
B. Status Bar 
C. Title Bar 
D. Scroll Bar 
Answer: C 

 

7.Tempat untuk mengetik dan mengedit teks pada Microsoft Word disebut … 
A. Menu Bar 
B. Area kerja 
C. Title Bar 
D. Status Bar 
Answer: B 

 

8.Ribbon pada Microsoft Word berfungsi untuk … 
A. Menyimpan file 
B. Menampilkan halaman 
C. Menampilkan menu dan perintah 
D. Menggulung halaman 
Answer: C 

 

9.Menu yang digunakan untuk mengatur jenis dan ukuran huruf adalah … 
A. Insert 
B. Home 
C. Layout 
D. View 
Answer: B 

 

10.Menu yang digunakan untuk menyisipkan gambar adalah … 
A. Home 
B. File 
C. Insert 
D. View 
Answer: C 

 

 

 



11.Menu yang digunakan untuk mengatur margin dan ukuran kertas adalah … 
A. Home 
B. Insert 
C. Layout 
D. Review 
Answer: C 

 

12.Fungsi utama menu File pada Microsoft Word adalah … 
A. Mengatur paragraf 
B. Mengelola dokumen 
C. Mengatur tampilan 
D. Mengedit teks 
Answer: B 

 

13.Fitur menyalin teks pada Microsoft Word disebut … 
A. Cut 
B. Paste 
C. Copy 
D. Delete 
Answer: C 

 

14.Fitur untuk memindahkan teks dari satu tempat ke tempat lain disebut … 
A. Copy 
B. Cut 
C. Undo 
D. Save 
Answer: B 

 

15.Perataan teks ke tengah dilakukan dengan memilih perintah … 
A. Align Left 
B. Align Right 
C. Center 
D. Justify 
Answer: C 

 

 

 



16.Spasi baris digunakan untuk mengatur … 
A. Jarak antar huruf 
B. Jarak antar kata 
C. Jarak antar baris 
D. Ukuran kertas 
Answer: C 

 

17.Ukuran kertas standar yang sering digunakan dalam Microsoft Word adalah … 
A. F4 
B. A4 
C. Letter 
D. Legal 
Answer: B 

 

18.Orientasi halaman tegak pada Microsoft Word disebut … 
A. Landscape 
B. Portrait 
C. Vertical 
D. Horizontal 
Answer: B 

 

19.Header pada Microsoft Word adalah … 
A. Teks di bagian bawah halaman 
B. Teks di bagian tengah halaman 
C. Teks di bagian atas halaman 
D. Teks di samping halaman 
Answer: C 

 

20.Footer pada Microsoft Word terletak di … 
A. Bagian atas halaman 
B. Bagian tengah halaman 
C. Bagian bawah halaman 
D. Bagian samping halaman 
Answer: C 

 

 

 



21.Nomor halaman biasanya ditambahkan melalui menu … 
A. Home 
B. Insert 
C. Layout 
D. File 
Answer: B 

 

22.Menu yang digunakan untuk melihat tampilan dokumen sebelum dicetak adalah … 
A. View 
B. Home 
C. Insert 
D. Review 
Answer: A 

 

23.Langkah pertama untuk mencetak dokumen adalah membuka menu … 
A. Insert 
B. View 
C. File 
D. Layout 
Answer: C 

 

24Tujuan menyimpan dokumen adalah … 
A. Menghapus file 
B. Mengamankan hasil pekerjaan 
C. Mempercantik tampilan 
D. Mengganti ukuran kertas 
Answer: B 

 

25.Microsoft Word banyak digunakan di sekolah dan perkantoran karena … 
A. Sulit dipelajari 
B. Fitur terbatas 
C. Membantu pengolahan dokumen teks 
D. Hanya bisa digunakan secara online 
Answer: C 

 

 

 


